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ВВЕДЕНИЕ 

Актуальность темы. На данном этапе развития человечества разработано 

очень много новых полезных решений различных задач, введение новшеств и 

модернизации. Одним из таких новшеств является использование разработанных 

САПР для создания 3D-моделей, которое в данный момент применяются по всюду. 

3D-моделирование используется для проектирования масштабных строительных 

объектов (жилые дома, торговые и бизнес центры, ландшафтные зоны).  

Цели и задачи работы. Целями данной работы является изучение всех 

возможностей САПР, к которым относятся AutoCAD, для создания 2D и 3D модели 

детали с выполнением разреза.  

Практическое значение. 3D-графика давно применяется в киноиндустрии и 

в теле-оформлении, но немногие знают насколько серьезно использование 3D-

моделирования, например, в архитектуре или проектировании. 3D-моделирование 

позволяет создать практически любую виртуальную среду и ее объекты. 

Использование 3D модели позволяет изучить, еще до того как они созданы в реале. 

Трехмерную модель можно осмотреть, вращать, измерить ее свойства. Для того чтобы 

создать качественную 3D-модель необходимо собрать максимум информации о 

моделируемом объекте, минимум необходимым фотографиям с разных ракурсов. 

Полученная информация приходиться в соответствии, затем создаются двухмерные 

проекции объекты, а уже потом строятся поверхности.  

Большое количество примеров, которые можно привести для внедрения технологии 

создания цифровых объемных топографических карт, они применяются в различных 

науках и технике.  

 

 



ОБЗОР СРЕДСТВ СОЗДАНИЯ И РЕДАКТИРОВАНИЯ КОМПЬЮТЕРНОЙ 

ГРАФИКИ 

САПР системы  

Программный пакет, предназначенный для создания чертежей, конструкторской и/или 

технологической документации и/или 3D моделей. Современные системы 

автоматизированного проектирования обычно используются совместно с системами 

автоматизации инженерных расчѐтов и анализа CAE. Данные из CAD-систем 

передаются в CAM (англ. Computer-aided manufacturing — система 

автоматизированной разработки программ обработки деталей для станков с ЧПУ или 

ГАПС (Гибких автоматизированных производственных систем)).  

Обычно охватывает создание геометрических моделей изделия (твердотельных, 

трехмерных, составных), а также генерацию чертежей изделия и их сопровождение. 

Следует отметить, что русский термин «САПР» по отношению к промышленным 

системам имеет более широкое толкование, чем «CAD» — он включает в себя CAD, 

CAM и CAE.  

CATIA  

CATIA — система автоматизированного проектирования (САПР) французской фирмы 

Dassault Systèmes. CATIA V1 была анонсировна в 1981 году. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 1 Интерфейс САПР CATIA 

В настоящий момент в мире используются две версии — V4 и V5, которые 

значительно отличаются между собой. CATIA V4 была анонсирована в 1993 году и 

создавалась для Unix-подобных операционных систем, CATIA V5 была анонсирована 

в 1998 году и это первая из версий, которая может работать под управлением Microsoft 



Windows. По заверению Dassault Systèmes CATIA V5 была написана с «нуля» и 

воплотила в себе передовые технологии САПР конца XX века — начала XXI века.  

В первое время CATIA V5 не пользовалась особой популярностью на рынке, и, чтобы 

стимулировать переход с V4 на V5, Dassault Systèmes выдвинула концепцию PLM 

(Product Lifecycle Management). Идея PLM оказалась удачной, и еѐ подхватила почти 

вся индустрия САПР.  

В феврале 2008 Dassault Systèmes анонсировала новую версию системы — CATIA 

V6. V6 будет поддерживать программы моделирования для всех инженерных 

дисциплин и коллективные бизнес-процессы на протяжении жизненного цикла 

изделия. Новая концепция фирмы получила название «PLM 2.0 на платформе V6». 

Суть концепции — трѐхмерное моделирование (3D) и коллективная работа в реальном 

времени. Для связи между людьми, находящимися в разных точках мира, 

предусмотрены средства простого подключения к Web.  

В PLM-решение V6 войдут системы CATIA для автоматизации проектирования, 

ENOVIA для управления инженерными данными и коллективной работы, SIMULIA 

для инженерного анализа и DELMIA для цифрового производства.  

Решения PLM V6 для малого и среднего бизнеса (SMB) разрабатываются израильским 

филиалом фирмы Dassault Systèmes Israel (SMARTEAM).  

Основными конкурентами являются NX от Siemens PLM Software и 

Pro/ENGINEER от Parametric Technology Corporation.  

Системные требования: Pentium 4 и выше, 2Gb RAM, 3D-видеокарта 64 Мб. 

Разрешение экрана: 1280х1024. Размер дистрибутива: все вместе ~6,6 Gb. Стоимость 

лицензии $14 795. 

САПР Компас  

КОМПАС — система автоматизированного проектирования, разработанная 

российской компанией «АСКОН» с возможностями оформления проектной и 

конструкторской документации согласно стандартам серии ЕСКД и СПДС.  

Существует в двух версиях: КОМПАС-График и КОМПАС-3D, соответственно 

предназначенных для плоского черчения и трѐхмерного проектирования.  

КОМПАС-График может использоваться как полностью интегрированный в 

КОМПАС-3D модуль работы с чертежами и эскизами, так и в качестве 

самостоятельного продукта, полностью закрывающего задачи 2D-проектирования и 

выпуска документации.  

Система ориентирована на поддержку стандартов ЕСКД и СПДС. КОМПАС-График 

автоматически генерирует ассоциативные виды трѐхмерных моделей (в том числе 

разрезы, сечения, местные разрезы, местные виды, виды по стрелке, виды с разрывом). 

Все они ассоциированы с моделью: изменения в модели приводят к изменению 

изображения на чертеже. 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 2. Интерфейс САПР Компас 

 Стандартные виды автоматически строятся в проекционной связи. Данные в основной 

надписи чертежа (обозначение, наименование, масса) синхронизируются с данными из 

трѐхмерной модели.  

 Существует большое количество дополнительных библиотек к системе 

КОМПАС, автоматизирующих различные специализированные задачи. Например, 

библиотека стандартных изделий позволяет добавлять уже готовые стандартные 

детали в трехмерные сборки (крепежные изделия, подшипники, элементы 

трубопроводов, шпонки, уплотнения), а также графические обозначения стандартных 

элементов на чертежи (обозначения отверстий), предоставляя возможность задания их 

параметров.  Системные требования: процессор Pentium III с тактовой частотой 800 

МГц; оперативная память 512 Мб; графический адаптер SVGA с видеопамятью 32 Мб; 

привод DVD-ROM; свободное пространство на жестком диске не менее 500 Мб; 

манипулятор "мышь". 

 Среди систем малого и среднего класса в мире наиболее популярна система 

AutoCad. Так же существуют такие САПР как CATIA (разработанная во Франции) и 

Компас (относящийся к Российским программам), но они не достигли широкого 

распространения.  

 



РЕАЛИЗАЦИЯ 3D МОДЕЛИРОВАНИЯ В СРЕДЕ AUTOCAD 

Присвоение атрибутов в AutoCad. 

 Чертежи существуют не в вакууме. Объекты на чертежах вполне реальны. Они 

обладают многими характеристиками, которые нельзя наглядно представить на 

чертеже, например фирма-изготовитель, дата приобретения и т.д. Эти сведения могут 

храниться в отдельной базе данных. Однако существует более удобный способ: 

используя атрибуты, данные о чертеже можно связать с блоками (атрибуты — это 

надписи, подключенные к блокам). Данные атрибутов можно извлечь и 

экспортировать в программу управления базой данных или электронными таблицами.  

Кроме того, есть возможность получить доступ к внешней базе данных или вставить 

ссылку на нее. Кроме того, данные можно получать из объектов, не являющихся 

блоками. Все эти средства доступны только в AutoCAD.  

 Атрибуты можно также использовать для записи текста, относящегося к блоку. 

Распространенный пример использования атрибутов — запись информации о блоке 

(имя чертежа, децимальный номер, дата, масштаб, учетный номер, чертежник и т.д.). 

Если извлекать данные об объекте не требуется, атрибуты можно использовать, чтобы 

облегчить вставку текста в блок штампа. Кроме того, в атрибуты можно добавлять 

текстовые поля (только в AutoCAD).  

 Использование атрибутов имеет некоторые ограничения. Подключать атрибуты 

можно только к блокам. Чтобы обойти это ограничение, можно создать фиктивный 

блок, состоящий только из атрибутов. Процесс извлечения данных при этом покажется 

несколько искусственным, но несмотря на ограничения атрибуты хорошо подходят 

для хранения небольшой базы данных и для размещения текста.  

Создание определений атрибутов. Прежде чем начать работу с атрибутами, 

следует начертить отдельные объекты, из которых будет сформирован блок. Если блок 

уже существует, его нужно расчленить, добавить атрибуты, а затем определить блок 

заново.  

 Исключение составляют случаи, когда атрибуты определяются без создания блока. 

Такие атрибуты могут понадобиться для извлечения информации, относящейся ко 

всему чертежу. После создания объектов выберите команду меню Draw>Block>Define 

Attributes (Рисование>Блок>Определение атрибутов). Будет запущена команда окно 

Attribute Definition (Определение атрибута), показанное на рис. 3.  Приборная панель 

содержит контрольную панель Block Attributes. По умолчанию она скрыта. Чтобы 

вывести ее, щелкните правой кнопкой мыши на приборной панели и выберите в 

контекстном меню команду Control Panels>Block Attri­butes (Контрольные 

панели>Атрибуты блоков). Для создания определения атрибута щелкните на кнопке 

Define Attributes (Определение атрибутов), расположенной на контрольной панели 

Block Attributes приборной панели.  

 



 

Рис. 3. Диалоговое окно Attribute Definition 

Группа Attribute. В поле Tag (Имя) группы Attribute задается имя атрибута 

(другие названия — тег или дескриптор атрибута). Оно используется при извлечении 

атрибутов. Имя атрибута соответствует полю в базе данных. Если данные 

импортируются, например, в электронную таблицу, то имена могут служить 

заголовками столбцов. Имя не должно содержать пробелов и восклицательных знаков. 

Оно автоматически преобразуется в верхний регистр. 

Группа Text Settings. Группа Text Settings (Параметры текста) используется 

для форматирования текста. Выберите необходимые параметры в раскрывающихся 

списках Justification (Выравнивание) и Text style (Текстовый стиль). Если атрибут не 

аннотированный, то при установке высоты учитывайте масштаб печати или видового 

экрана. Можно также задать угол поворота текста в поле Rotation (Поворот). 

Группа Insertion Point. В группе Insertion Point (Точка вставки) установите 

флажок Specify On-screen (Задать на экране), чтобы указать точку вставки на чертеже. 

Если снять флажок, точку вставки можно будет задать путем ввода координат. При 

использовании атрибутов для размещения текста в блоке штампа или в каком-либо 

расписании точка вставки весьма важна. При вставке невидимого атрибута точка 

вставки неважна, распложите его просто рядом с блоком. При создании нескольких 

атрибутов для одного блока разместите их аккуратно, например в одной колонке. 

Заполнив диалоговое окно Attribute Definition, щелкните на кнопке OK. Если задано 

указание точки вставки на экране, щелкните в нужной точке чертежа. 

Редактирование атрибутов. Перед созданием блока можно изменять 

свойства тегов атрибутов с помощью палитры свойств или команды DDEDIT (чтобы 

запустить ее, выберите команду меню Modify>Object>Text>Edit). Если блок уже 

создан, то в AutoCAD воспользуйтесь диалоговым окном Block Attribute Manager 

(Менеджер атрибутов блока). С его помощью можно управлять всеми значениями и 

свойствами атрибутов блока. В AutoCAD LT используйте диалоговое окно Edit 

Attribute (Редактирование атрибутов), которое активизируется командой ATTEDIT.  

 



Редактирование свойств атрибута в AutoCAD  

Если вы уже вставили блок и присвоили значения всем его атрибутам, то 

изменить сможете только следующее:  

 последовательность вывода подсказок атрибутов;  

 теги и подсказки;  

 видимость атрибутов;  

 параметры текста;  

 свойства (слой, типы линий, цвет, толщина линий и стиль печати);  

 значения.  

После внесения изменений можно обновить все блоки чертежа, чтобы отразить в них 

эти изменения.  

Чтобы запустить команду BATTMAN, которая активизирует диалоговое окно Block 

Attribute Manager, выберите команду Modify>Object>Attribute>Block Attribute Manager 

(Редактирование>Объект>Атрибут>Менеджер атрибутов блока).  

 

 

 

 

 

 

СОЗДАНИЕ АТРИБУТОВ 

 На чертеже изображен увеличенный план офиса, на экране виден только один 

кабинет. Файл содержит вставленный комплект офисной мебели (рис. 5).  

 Щелкаем на кнопке Explode, расположенной на панели инструментов Modify или на 

приборной панели. Выделяем мебель в офисе. Блок содержит вложенные блоки. 

Выделяем стул и снова проводим расчленение на составляющие объекты.  

 Выбераем команду Draw>Block>Define Attributes (Рисование>Блок>Определение 

атрибутов). В группе Mode (Режим) диалогового окна Attribute definition (Определение 

атрибута) установливаем флажок Invisible (Невидимый).  

 В группе Attribute (Атрибут) в поле имени вводим mfr, в поле подсказки — 

Manufacturer, в поле значения — American Office Furniture.  

 

 

 



 

 

 

 

 

 

 

 

 

Рис. 5 Помещение офиса с комплектом офисной мебели 

 Параметры группы Text settings не изменяем. Установливаем флажок Specify on-

screen и щелкаем на кнопке OK. Указываем точку 1. 

 Повторяем команду ATTDEF. Установливаем флажок Align below previous attribute 

(Выравнивание по предыдущему атрибуту). Введим в поле имени фразу pur_date, в 

поле подсказки — Date purchased, а в поле значения — 3/91.  

 Щелкаем на кнопке OK.  

Щелкаем на кнопке Make Block, расположенной на панели инструментов Draw или на 

приборной панели. В поле Name вводим armchair. Щелкаем на кнопке Select Objects 

(Выделить объекты). Выделяем полностью все кресло и два атрибута. Завершаем 

выделение. В диалоговом окне появилось сообщение о том, что найдено 18 объектов. 

Щелкаем на кнопке Pick Point. Используем объектную привязку конечной точки, 

чтобы указать точку 2 в качестве базовой. Установите переключатель Delete 

(Удалить). Щелкните на кнопке OK.  

 На запрос, желаете ли вы переопределить блок, отвечаем Yes. (Программа выводит 

это приглашение, поскольку на чертеже уже есть блок с таким же именем.)  

 Сохраняем чертеж.  

 При переопределении блока обновляются только его геометрические 

параметры, а не атрибуты. Следовательно, если к блоку были добавлены определения 

атрибутов, то эти атрибуты будут передаваться только новым вставляемым блокам. 

Существующие блоки не получат новых определений атрибутов. Чтобы обновить 

существующие блоки (добавить в них текущие определения атрибутов), применяем 

команду ATTSYNC (Синхронизация атрибутов). 

 

 

 

 



ПРОЕКТИРОВАНИЕ В AUTOCAD 2D МОДЕЛИ ДЕТАЛИ. 

 

 

 Даны 2 вида детали:  

 

 

 В данной работе нам задано два вида детали. 

С помощью программы САПР AutoCad 2008 

следует построить третий вид. Для начала 

требуется создать слои. На панели 

инструментов Layers нажимаем кнопку Layer 

Properties Manager. Откроется окно в котором 

и будут создаваться слои при нажатии кнопки 

New Layer. 

 

 

 

 

 

 

 

 

 

 

 

  

Рис. 6. Слои в Layer Properties Manager. 

 После создания слоев начинаем построение линий осей, а так же вспомогательных 

линий. Линии эти строятся с помощью команды Construction Line. После этого 

начинаем построение самой детали. Выполняется это с помощью команд Line, 

Rectangle, Circle на панели инструментов Draw.  

 Далее нам требуется построить линии осей симметрии, а также невидимые линии. 

Линии осей симметрии строятся штрих пунктирной линией, а невидимые - 

пунктирной. Для этого требуется открыть окно Lauer Properties Manager > Linetype. 

Открывается окно Select Linetype (рис. 6.). 



Далее при помощи проекционных связей строим третий вид детали. 

 

 

 

 

 

 

 

 

 

 

 

Рис. 7.Три вида детали 

 Для завершения работы остается обозначить все размеры на чертеже. Для этого в 

меню Dimension выбираем команду Linear, Diameter и наносим все размеры. 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 8. Готовый чертѐж детали. 

Таким образом мы выполнили построение детали в трех проекциях и  получили 

готовый чертѐж детали, который отображает геометрическую форму детали и еѐ 

размеры.  



ПРОЕКТИРОВАНИЕ 3D МОДЕЛИ И ВЫПОЛНЕНИЕ 

РАЗРЕЗА В AUTOCAD. 

Нам требуется смоделировать деталь в трехмерном пространстве. Для этого 

используем примитивы cylinder и box, wedge. Для объединения частей детали 

используем команду union, а для вычитания subtract. 

 

 

 

 

 

 

 

 

 

Рис. 9. Готовый чертѐж детали. 

Таким образом мы выполнили построение детали в трех проекциях и  получили 

готовый чертѐж детали, который отображает геометрическую форму детали и еѐ 

размеры.  

ПРОЕКТИРОВАНИЕ 3D МОДЕЛИ И ВЫПОЛНЕНИЕ РАЗРЕЗА В 

AUTOCAD. 

Нам требуется смоделировать деталь в трехмерном пространстве. Для этого 

используем примитивы cylinder и box, wedge. Для объединения частей детали 

используем команду union, а для вычитания subtract. 

 

 

 

 

 

 

 

 

 

Рис. 10. Модель детали с вырезом. 



Создаѐм видовые экраны. Для этого заходим в layout и при помощи инструмента 

vports располагаем необходимые видовые экраны.  
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Рис. 11. Пространство листа  

Таким образом мы получили 3d модель детали с вырезом и подготовили еѐ для 

печати. 

 

СПИСОК УСЛОВНЫХ СОКРАЩЕНИЙ 

 ПК - персональный компьютер;  

 СК - система координат;  

 РГР - расчетно-графическая работа;  

 САПР - система автоматизации проектных работ;  

 CAD - Computer-Aided Design;  
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